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1. Before You Begin 
Welcome to the FAA eForm Service Help system. This system will guide you through the different aspects of 
using the electronic forms. It will walk you through Form Manager, provide answers to general questions, 
cover system access, and much more. 

If you have any problems, need assistance with the form, or have requests to make changes* or additions, 
please feel free to contact the AVS National Service Desk (NSD) 24 hours/7days a week. 

Phone:  1-877-AVS-NSD1 (1-877-287-6731) 

Email:  AVS National Service Desk 

 

*NOTE: All updates to forms within the eForm Service are only to bring them into compliance with the 
existing forms as designed by the form owners. The eForm Service does NOT alter the actual form design 
or make changes that are not on these existing forms. 

 

2. System Requirements 
The following operating system has been tested and certified to work with the eForm Service and 
subsequent forms. Therefore, we can provide user support only for this environment. 

 
Windows Platforms (Supported by Aviation Safety) 
• Adobe Acrobat v10.1.1 (or later) or Adobe Reader v10 (or later) 

• Adobe Flash Player v11.6.602.168 (or later) 

• Intel 1.3 GHz processor (or faster) 

• Microsoft Windows 7 with Service Pack 1; XP Professional or Home Edition, or Tablet PC with 
Service Pack 2; Windows 2000 with Service Pack 4; Windows Server 2003 

• 128MB of RAM (256MB or higher recommended)  

• 335MB of available hard disk space 

• Microsoft Internet Explorer 8.0 (32-bit) 

   
 

Although Adobe Corporation advertises that their Reader product works on other operating systems 
(see list below), Aviation Safety does not have the resources to support these multiple platforms. 

Windows Platforms or Applications (Not supported by Aviation Safety) 
• Firefox 

• Google Chrome 

• Apple Safari 

 

http://eformservice.faa.gov/Email.aspx
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Macintosh  
• Adobe Reader v10 (or later) 

• Adobe Flash Player v10.3.181.14 (or later) 

• PowerPC G4, G5, or Intel processor  

• Mac OS X v10.4.11 to 10.5.6  

• 128MB of RAM (256MB or higher recommended)  

• 405MB of available hard disk space  

• Safari 2.0.4 (or later)  

 
Linux  
• Adobe Reader v10 (or later) 

• Adobe Flash Player v10.3.181.14 (or later) 

• 32-bit Intel Pentium processor or equivalent 

• Red Hat Linux WS 5, SUSE Linux Enterprise Desktop (SLED) 10 SP2 and Ubuntu 7.10  

• GNOME or KDE Desktop Environment 

• 512MB of RAM (1GB recommended) 

• 150MB of available hard-disk space (additional 75MB required for all supported font packs)  

• GTK+ (GIMP Toolkit) user interface library, version 2.6 (or later)  

• Firefox 2.0 (or later) 

• OpenLDAP and CUPS libraries 

 
Solaris  
• Adobe Reader v10 (or later) 

• Adobe Flash Player v10.3.181.14 (or later) 

• 32-bit Intel Pentium processor or equivalent 

• Solaris 10 u5 or OpenSolaris 2008.11  

• GNOME or KDE Desktop Environment (GNOME only for Solaris 10) 

• 512MB or higher of available RAM (1GB recommended) 

• 200MB of available hard-disk space (additional 75MB required for all supported font packs) 

• GNU C library (glibc) version 2.3 (or later) 

• GTK+ (GIMP Toolkit) user interface library, version 2.6 (or later) (On Solaris10, also works with 
GTK 2.4.9 also) 

• Firefox 2.0 (or later) 

• Open LDAP and CUPS libraries 
 

NOTE:  Currently, touchpads such as the iPad, Kindle Fire, Nook or other similar devices 
have NOT been tested with eForms. 
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3. Searching for a Help Topic 
Use the Search feature in the Help system to easily find a topic. Typing a keyword or set of words 
(i.e. digital signature) in the Search box will display a list of topics that contain that word. Select the 
most likely topic that will have the information you need. 

 
 

4. Block or Allow Web Site Trusts 
To manually allow web sites or change a web site from 'blocked' to 'allowed', follow the instructions 
below.  

Manually Allow Web Sites 
1. Open Adobe Acrobat or Adobe Reader. 
2. Click Edit > Preferences on the menu bar at the top of the screen. 
3. Select Trust Manager in the Categories list. 
4. Click the Change Site Settings button under the Resource Access section. 
5. Type the web address in the text box. 
6. Click the Allow button. 
7. Click the OK button to save and close the Preferences. 

  
IMPORTANT:  To use the eForm Service where data searches are involved, it is required to always 
allow the eformservice.faa.gov web site trust. 

 
Change Blocked Web Sites to Allowed 
1. Open Adobe Acrobat or Adobe Reader. 
2. Click Edit > Preferences on the menu bar at the top of the screen. 
3. Select Trust Manager in the Categories list. 
4. Click the Change Site Settings button under the Resource Access section. 
5. Highlight the web site in the Site listing that you want to unblock. 
6. Click the Remove button. 
7. To allow the web site:  

• The next time you access the web site it will ask you to Allow or Block the web site you are 
entering. Click the Allow button. The web site will add itself to the Allow list in Adobe. 

• If you want to manually add the web site instead of waiting till the next time you visit the 
web site, follow the above set of instructions on how to manually allow web sites.  

8. Click the OK button to save and close the Preferences. 
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5. Turn Off/On Adobe Auto Complete 
 
Turn On Adobe Auto Complete 
1. Open Adobe Acrobat or Adobe Reader. (Note: The screenshot below of the Preferences Dialog 

Box was taken from Adobe Acrobat. Adobe Reader may look slightly different.) 
2. Click Edit > Preferences on the menu bar at the top of the screen. 
3. Select Forms in the Categories list. 
4. Near bottom of the screen, under Auto-Complete, click on the drop down box and change the 

settings from 'Off to 'Basic'. 
5. Click the OK button to save and close the Preferences. 

 

 
 
 

Turn Off Adobe Auto Complete 
1. Open Adobe Acrobat Reader or click AcroRd32.exe to open Adobe Acrobat Reader. 
2. Click Edit > Preferences on the menu bar at the top of the screen. 
3. Select Forms in the Categories list. 
4. Near bottom of the screen, under Auto-Complete, click on the drop-down box and change the 

settings from 'Basic' to 'Off'. 
5. Click the OK button to save and close the Preferences. 
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6. User Support 
The eForms home page contains the User Support links on the left side of the window. 

 
 
 

To contact AVS National Service Desk, click on “User Support” on the home page. The following 
window is displayed, which contains the phone numbers and an email link to AVS National Service 
Desk. 
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To access the eForm Service Help Topics and the User Guide, click on “Help Topics” on the home 
page. The following window is displayed, which contains the link to the Help Topics and User Guide. 

 
 

To access the eForm Service Tutorials, click “Tutorials” on the home page to display a menu page 
with links to several tutorials. 
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7. eForms 

7.1 User Login/Logout 

7.1.1 Login 
To enter the eForm system, follow the login procedure below. 

 
1. Access the http://eformservice.faa.gov/eForms.aspx web site. 
2. Click the Login link on the left navigation pane. 

 

 
 

 

http://eformservice.faa.gov/eForms.aspx
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3. A “System Use Notice” page appears. To proceed to the eForm login page, click on the I Agree 
button. 
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4. Enter the User ID and Password that you use to access your computer and click the Login 
button. 

 

 
 

NOTE:  After five attempts of entering the wrong login information, the system will log you 
out as shown below. Close the browser, re-open it, and re-navigate back to the Login page. 
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7.1.2 Logout 
1. To log out of the eForm system, click on the Logout button on the top menu bar of the Form 

Manager. 
 

 
 
 

2. A confirmation window will appear, as shown below.  Click OK to exit the Form Manager. 
 

 
 

7.1.3 Using Single Sign-On 
 
About Oracle Enterprise Single Sign-on Logon Manager (ESSO-LM) 
The ESSO-LM program simplifies your application/system access by centrally storing your login 
credentials (usernames/passwords) and then automatically logging you in when you access those 
sites. This reduces the amount of times you will need to input your username and password. 

When initially accessing supported ESSO-LM sites, the sign-on program will prompt you for your 
login credentials in order to associate with that system. Since most systems require periodic 
password changes, your stored ESSO-LM credentials for each application must be updated when 
each system password (or username) changes. 

 

Using ESSO-LM for eForms Access 
To add the eForm Service application to ESSO-LM, do the following: 

1. Right-click the ESSO-LM icon in the system tray on the bottom of the screen and select 
Configure. 
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2. From the Oracle Enterprise Single Sign-On Logon Manager, click the Add button. 
 

 
 

3. If you did not log in to ESSO-LM during boot-up, the login box will appear as shown in the 
example below. Enter your Windows password and click OK. 

 

 
 

4. In the New Logon box, select Web for the application type and eFORM from the list of 
applications. Then, click NEXT to continue. 
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5. Enter the Username and Password that you use to access the eForm Service, and then confirm 
your password. Click Finish when done. 

NOTE:  If you already logged in to ESSO-LM upon boot-up, you will only need to enter and 
confirm your password. 
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6. The eFORM application should appear under the Oracle Enterprise Single Sign-on Logon 
Manager box as show in the example below. 

 

 
 

The next time you access the eForm Service, your username/password credentials will be 
entered automatically and you will be routed directly to the Form Manager. 

7. For further details on ESSO-LM and its features, right-click on the  icon in the system tray. 
Then, select Help and click on Oracle Enterprise Single Sign-on Logon Manager. 
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7.2 Display Options 

7.2.1 Create More Room to See the Form 
To create more room to see the form, you can hide the following toolbars. 

• Form Tabs 

• Document Message Bar 

• Form Toolbar 

 

 
  

7.2.2 Hide/Show Form Tabs 
To increase the visible area of the form, click the Maximize/Minimize button on the right side of 
the Form Tabs. Click the button again to reduce the form to its previous size as necessary. 
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7.2.3 Hide/Show Form Toolbar 
NOTE:  Depending on the version of Adobe Acrobat or Reader you’re using in your web browser, 
your toolbar views and options may differ from the examples shown here. 

To hide or show the Form toolbar, follow the instructions below. 

 
 
 

Hide Form Toolbar  
To hide the Form Toolbar, right-click on a blank part of the toolbar and select "Hide Toolbars", or 
press the F8 key on the keyboard. 

NOTE:  You can also right-click anywhere on the toolbar and select Show/Hide Toolbars > Hide 
Toolbars. 

 
 

 Show Form Toolbar  
To display the Form Toolbar, click anywhere on the form and press the F8 key on the keyboard. 
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7.2.4 Hide/Show Document Message Bar 
The Document Message Bar contains instructions on how to proceed with the form and includes 
special buttons associated with the task. The bar is color coded: purple for forms, yellow for reviews, 
and blue for certified or secure PDFs.  

To hide or show the Document Message Bar, follow the instruction below. 
 

 

 
 

   

Click the Forms button  on the left to hide or show the Document Message Bar.  Whatever it is 
set to when the form is closed is maintained the next time the form is opened. 
  

Click the Highlight Fields button  to the right of the bar to highlight the sections on the form 
that need to be filled out. 
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7.3 Navigating Form Manager 

7.3.1 Top Menu Bar 
The menu bar is located at the very top of the Form Manager screen. It allows you to set your 
preferences, read system messages, get eForm Service help, and log out. The Menu Bar is shown 
below: 

 

 
 

 

A brief description of the Top Menu Bar: 

Preferences:  Change your global preferences for the Form Manager. For more about setting 
your preferences see the Setting My Preferences Help topic. 
Messages:  These are notices of events that occur during your current session. The messages 
are about two types of events: 

• System events, such as login and server errors 
• Business process events, such as completion of a task and new tasks arriving in your 

Worklist 

To sort the messages in ascending or descending order, click the Description column 
heading. Click Exit Messages to exit the page. 

eForms Admin: This link is available only to internal AVS users who are authorized to perform 
various functions pertaining to the eForm Service (i.e. reporting, user account requests, etc). 

Help:  This option provides a link to eForm Service Help Topics and a link that displays system 
information about the AVS Form Manager. 

Logout:  This option logs you out of the Form Manager.  When selected, a confirmation window 
will appear, as shown below. 
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7.3.2 Form Directory Panel 
Use the form directory panel on the left side of the Form Manager to browse for forms. This panel 
(see example below) displays forms in different categories and allows for easy organization of the 
forms.  

NOTE:  To open a form in any category, make sure to double-click on the form name instead of the 
star icon next to it. Clicking the star icon adds/removes the form to/from the Favorites category. 

 

 
 
 

Searching for Forms 
On top of the Form Directory Panel is a Search box to help you find the forms easily. Type the name 
of a particular form in the Search field and a list of all forms that match the search criteria will 
appear. As you type a character, any form that has that character in its name will appear until the 
search parameter is narrowed to the form you want.  
 
  

Related Topics:  

Setting Favorites 

Searching for a Form 
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7.3.3 Form Manager Tabs 
 

The Form Manager Tabs consist of the Worklist tab, In Progress tab, and Archived tab.  These 
tabs help organize the forms in the workflow.  

To view or process a form, position the mouse pointer over the task, which will also highlight it, and 
double-click to open the form. You can have only one form open at a time. Placing the mouse 
pointer over the task will also display a box containing information about that task. 

To view the list in ascending or descending order, click on the corresponding column heading (such 
as by Process ID, Process Name, etc.) to rearrange the view as desired. 

 

 
 

Worklist Tab 

The Worklist tab (as shown in example above) lists active forms that need to be processed for either 
approval or rejection (if submitted to you as part of a workflow, i.e. the Form 337) or forms saved as 
draft and awaiting future editing. See the "Worklist Overview" Help topic for more details. 

 

In Progress Tab 

The In Progress tab lists the workflow forms that have an automated business process (i.e. the 
Form 337) and are currently in progress and waiting for review, approval, rejection, etc. These forms 
are read-only. See the "In Progress Overview" Help topic for more details.  

 

Archived Tab 

The Archived Tab lists the completed Workflow forms that you submitted online. These are read-
only copies of the form and cannot be edited. EForms without a workflow and are not associated 
with a tracking number may be edited when you create a new instance of the form. See the 
"Archived Overview" and "Create a New Form" Help topics for more details. 
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7.3.4 Form Tabs 
The Form Tabs for most electronic forms consists of Task Details and Form.  The Attachments 
tab is not available on all forms; this tab will appear only on forms that allow the attachment of files 
or notes with the form submission.  

NOTE: Forms that allow the user to forward a task to someone else will also display a Forwarding 
tab on the Form Tabs.   

 
 

 
Task Details 
The Task Details tab displays general information about the type of task and specific information 
about the current task and process. 

On the bottom of the tab window are icons that allow you to lock/unlock the task, forward the task (if 
applicable) to another user, or abandon and delete the task from your worklist. 
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Form 
 

The form is displayed in .pdf format and process buttons are provided on the bottom of the window.  

The Save to Worklist (Draft) button  on the lower-left corner allows you to save the form 
and complete it at a later time. See the "Saving to Worklist (Draft)" Help topic for more details. 

 

The Take this Form Offline button  allows you to save a copy of the form on your 
computer or an external device. 
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Attachments 
You can add notes and file attachments to a form if the process allows it. Other users who 
participate in the process can view, update, and delete the notes or attachments if you provide 
permission. For more details, see the Help Topic for specific forms that have this feature. 

 

 
 

7.3.5 Form Navigation Pane 
The Form Navigation Pane adds more functionality to the electronic Forms. To show or hide the 
Navigation Pane, right-click on the left side of the window and select “Show Navigation Pane 
Buttons” or “Hide Navigation Pane Buttons”. By default, only a selected set of these buttons appears 
on the left side of the work area. Click the buttons to show or hide the views. 
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NOTE:  Depending on the version of Adobe Acrobat or Reader you’re using in your web browser, 
the buttons in the navigation pane may differ from the examples shown here. 

 
• Forms  

• Pages 

• Attachments 

• Search 

• Signatures 

 
An example of the Navigation Pane is shown below: 

 

   
 

7.3.5.1 Forms 

The Forms button  shows the Document Message Bar, which contains instructions on 
how to proceed with the form and includes special buttons associated with the task. The bar 
is color coded: purple for forms, yellow for reviews, and blue for certified or secure PDFs 
(such as when a signature is present). Click on the Highlight Fields button to the right of 
the bar to highlight form fields. 
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7.3.5.2 Pages 
The Pages button displays the Page thumbnails, which are miniature previews of the pages 
in a document. Click on the thumbnail to jump quickly to a specific page.  

 

7.3.5.3 Attachments 
Ignore the Attachment button (paperclip) in the navigation pane. This has been disabled for 
the current version of the system. 

 

7.3.5.4 Search 
The Search button displays a panel that allows the user to run searches to find a specific 
word or phrase in the document. 
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7.3.5.5 Signatures 
The Signatures button appears for documents that require a digital signature (i.e. Form 
337). The Signatures panel contains information about each signature in the document. 
Each signature will have an icon identifying its verification status and can be viewed by 
expanding the signature. The Signatures panel also provides information about the time the 
document was signed and other signature details. 
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7.4 Form Manager Tools 

7.4.1 Overview 
 

The LiveCycle Form Manager enables the use of the web browser to find, organize, and process 
eforms. Use LiveCycle Form Manager to perform the following tasks:  

• Open and fill out forms in the web browser 

• Find forms quickly and easily 

• Reuse forms that were previously completed 

• Customize the presentation of forms 

 
With LiveCycle Form Manager (see example below), the user can also initiate online routing and 
automated processing of .pdf forms within the user's organization. 

 
 

7.4.2 Setting Preferences 
 

Preferences allows customization of the Form Manager for personal viewing. This feature is divided 
into two categories: 

 
• Manage Out of Office 

• Manage Worklists 
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7.4.2.1 Manage Out of Office 
Set preferences to control how your tasks are assigned to other people while you are out of 
the office.  In your absence, you allow others to process or complete forms on your behalf 
(i.e. approve or reject for the Form 337 process). You can also specify exceptions for tasks 
from specific processes to be sent to another user or remain in your worklist until you return.  

 

 
 

To specify when you are out of the office, do one of the following options: 

• If you are out of the office for an indefinite time period, select Out of the Office but do not add a 
date range 

• To specify a start date and time that you will be out of the office, select Out of the Office and 
click Add Date Range 

To specify how your tasks will be handled by default, select one of the following options: 

• Select Do not assign to keep tasks in your worklist until you return 

• Select Find User to search for a user to assign your tasks to.  When you select a user, you can 
also view their out-of-office schedule 

To set exceptions to the default, click Add an Exception and select a specific form to assign to a 
specific user as necessary. 

Click Save when you've finished setting your preferences. 

Click Exit Preferences on the bottom right corner of the tab window when finished. 
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7.4.2.2 Manage Worklists 

Share my worklists 
Selecting Share my worklists allows you to provide any number of people with access to 
your worklist.  

NOTE:  Only new draft forms or new assigned tasks (i.e. Form 337) can be viewed in a 
Worklist AFTER an Out of Office or Manage Worklist preference setting has been 
established. 

NOTE: Due to privacy issues, Human Resource/Personnel type forms cannot be shared. 

The form disappears from your worklist when the user to whom you have given access 
opens the form. That user becomes the owner of the form until it is forwarded to another 
user. 

 

To share your worklist, do the following: 
1. Select Share my worklist. 

2. Type the name or partial name of the user in the Name text box. 
 
NOTE:  You can enter either the first name or the last name (not both) or the format of 
(lastname, firstname). User name is not case-sensitive.   

3. Click Find to list all of the user names that match the search criteria.  
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4. Select the name of the user and click Share or double-click the user name. A list of 
users who are currently sharing your worklist will appear on the right side of the page.   

5. To delete the name of users from the list, select the name from the User Currently 
Sharing My Worklist window and click Remove on the bottom right of the list 
window.  

 

Access another worklist 
Selecting Access another worklist allows you to submit a request to access another 
worklist and displays a list of worklists in which you have access. 

 

 

To access another worklist, do the following: 
1. Select Access another worklist. 

2. Type the name or partial name of the user in the Name text box whose worklist you 
want to access. 
 
NOTE:  You can enter either the first name or the last name (not both) or the format of 
(lastname, firstname). User name is not case-sensitive. 
  

3. Click Find to list all user names that match the search criteria.  

4. Select the name of the user and click Request. A list of users whose worklist you will 
have access to will appear on the right side of the page. 
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5. To remove your access to another worklist, select the user name from the Users 
Worklist That I have Access To list and click Remove on the bottom right of the list 
window.  

NOTE: You cannot remove your access to another worklist when the request to access the 
worklist is still pending. 

7.5 Form Categories 

7.5.1 Setting Favorites 
The Favorites category (see example below) is in the Form Directory Panel, located on the left side 
of the Form Manager window. 

By setting favorites, you can group all the forms that are used frequently into a single category so 
that you can find them quickly. 

 

 
 

7.5.1.1 Adding and Removing Forms in the Favorites Category 
 

1. Select the category that contains the form. 

2. Click the hollow star icon next to the form name. The form is added to your 

Favorites category, and a solid star appears next to the form to indicate that the 
form is a favorite. 

3. To remove a form from the Favorites category, click the star again. The form appears in 
its original category with a hollow star next to the name. 

NOTE:  Be sure to click on the star icon; accidentally double-clicking on the form name will 
open the form. 
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7.5.2 Worklist 

7.5.2.1 Worklist Overview 
The Worklist tab displays a list of active forms that are still in process. It could include 
forms that are sent to you as part of an automated workflow and need to be processed for 
approval or rejection (i.e. a Form 337), or forms that were saved for future editing or 
completion. 

 

NOTE:  To view the list in ascending or descending order (such as by Process ID, Process 
Name, etc.), click on the corresponding column heading to rearrange the view as desired. 

 

 
 

Open a Form in the Worklist Tab 
To view or process a form, position the mouse pointer over a task, which will also highlight 
it, and double-click to open the form.  Placing the mouse pointer over the task will also 
display a box containing information about that task. A .pdf copy of the form will open in the 
same window. You can have only one form open at a time. 

 

Forward a Form in the Worklist Tab 
If the process allows it, you can choose to forward a form to another user by clicking on the 
Forward icon .  Refer to Forwarding a Task for further details. 
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7.5.2.2 Worklist Columns  
The Worklist page displays all forms that require some action and consists of columns that 
show the process ID, name, instructions for the task, form/task description, and date the 
form was last updated. 

 

 
 

Process ID:  Unique technical (system) ID number that identifies each form upon execution 
of a process. It is "0" (zero) until the first time the Complete button is clicked in the form user 
interface. 

Process Name: Name of the form or process. 

Instructions:  Any instructions needed to process the form. 

Description:  Description of the form/workflow process. 

Updated Date:  The date the process was last updated. 
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7.5.2.3 Change Task Description in Worklist 
The description for each form or task can be changed (or added) while in Worklist view. 

NOTE:  This description is used for organizing your own Worklist and does not go with the 
task when it is sent to the next stage of the process. The only exception is when the task is 
forwarded to another user since the description stays only with forwarded tasks. 

Refer to Changing Task Description in Worklist View Help Topic in the Working with the 
Form category to change the description for a form or task in the Worklist view. 

 

7.5.2.4 Forward a Form 
While in the Worklist tab, you can forward a form or task to another user by clicking on the 
Forward icon  (see example below).  Refer to Forwarding a Form for further details. 

 

 
 
 

Related Topics: 

 

Forwarding a Form 
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7.5.2.5 Delete a Draft Form 
NOTE:  Only the author of the form can delete a draft form.  

A form that was saved to Draft will appear on the Worklist with a  icon to the left of the 
form (see example below). To delete the draft form, simply click on the trash icon to the right 
of the form. Note that this action cannot be undone. 

 

 
 

After clicking the trash icon, a confirmation box appears, as shown below.  Click OK when 
ready or Cancel to return to the Worklist. 
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7.5.3 In Progress 

7.5.3.1 Overview 
The In Progress tab lists forms that are in progress but not yet finalized. Each item can be 
identified by the unique Process ID. Double-clicking on any of the items on the list will 
display two tabs:  Process Details and Audit 

NOTE:  Users can view the Audit (History) under the In Progress tab for forms that have an 
automated business process (i.e. for Form 337). 

To view the list in ascending or descending order (such as by Process ID, Tracking No., 
etc.), click on the corresponding column heading to rearrange the view as desired. 
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Process Details 
On the Process Details tab, you can view basic details about the process instance, including 
its creation date, status, and other information regarding the task. 
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Audit 
On the Audit tab, you can view the tasks that are part of the process instance and the 
associated form, assignments, and attachments for each task. 
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7.5.4 Archived 

7.5.4.1 Overview 
The Archived tab displays a list of eforms that you submitted. You can view the Audit 
(History) for all your completed forms under the Archived tab. These forms are all read-
only. Archived copies are viewable for 365 days. By default, the page displays forms 
processed for the last 60 days, but you may click on the calendar icon  to perform a 
search as early as 365 days from the current date. 

An example of the Archived tab is shown below. Double-clicking on any of the items on the 
list will display two tabs:  Process Details and Audit 

Any eForm that has just been completed will appear under Archived. Hit the F5 key to 
refresh the page as necessary. A Form 337 will appear under Archived only after it has 
been approved. 

NOTE:  To view the list in ascending or descending order (such as by Process ID, Task ID, 
etc.), click on the corresponding column heading to rearrange the view as desired. 
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Process Details 
On the Process Details tab, you can view basic details about the process instance, including 
its creation date, status, and other information regarding the task. 
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Audit 
On the Audit tab, you can view the tasks that are part of the process instance and the 
associated form, assignments, and attachments (if allowed by process) for each task. 
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7.5.4.2 View Archived Form 
To view a completed form in the Archived category, go to the Audit tab and click on the View 
Form icon  to open the form. Note that the form is read-only. You can also view the 
Assignments and the Notes and Attachments (if allowed by process) for each completed 
task by clicking and expanding the related icons in the Audit tab. See example below. 
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7.5.4.3 View Audit Trail 
To view the audit trail for a completed form, click on a form in the Archived category and go 
to the Audit tab to see the workflow history. See example below. 
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7.5.4.4 Change Task Description in Archived 
The description for each form or task can also be changed (or added) while in the Archived 
view, as well as the Worklist view. 

NOTE:  This description is used for organizing your Archived views and does not go with the 
task when it is sent to the next stage of the workflow process. The only exception is when 
the task is forwarded to another user since the description stays only with forwarded tasks. 

Refer to Changing Task Description in Archived View Help Topic in the Working with the 
Form category to change the description for a form or task in the Archived view. 

 

7.5.4.5 Create a New Form 
In the Archived category, a new instance of the form can be created from an existing form 

by clicking the New Form icon  on the bottom left corner of the page.  Data entries in 
the existing form may be retained as needed and all fields are editable. 

NOTE:  This function is not available for archived forms that were processed using a 
workflow, such as the Form 337, due to unique tracking numbers associated with the forms. 
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7.6 Working with the Form 

7.6.1 Form Manager Icons 
The Adobe LiveCycle Form Manager will display several different icons that act as buttons to aid in 
the processing of the eForms. The definitions below will help you recognize the difference between 
each of the icons used in the eForm Workflow process. The use of these icons is also covered in 
various Help Topics that include more information about their function in the workflow. 

 

  Attachment - Save: This icon of a paperclip with blue down arrow is found under the 
Attachments tab. Click on this icon to save a file attachment to your computer or an external device. 
Some electronic forms may not have the Attachment feature. 

 

  Attachment - Update: This icon of a paperclip with a blue up arrow is found under the 
Attachments tab. Click on this icon to upload an updated file attachment to the form. Some 
electronic forms may not have the Attachment feature. 
 

  Audit - View Assignments:  This icon is found in the Audit view of a task under the In 
Progress tab and the Archived tab. Click on this icon to view the assignments for the task. 

 
 

  Audit - View Attachments:  This icon is found in the Audit view of a task under the In 
Progress tab and the Archived tab. Click on this icon to view the attachments for the task. 

 

  Audit - View Form:  This icon is found in the Audit view of a task under the In Progress tab 
and the Archived tab. Click on this icon to view the form for the task. 

 

  Claim task and make it your own: This icon of an open lock is found under the Task Details 
tab of a shared task.  Click on this icon to claim the task and add it to your own Worklist for future 
work. 

 

  Claim and open task: This icon of an open lock with a blue right arrow is found under the 
Task Details tab of a shared task. Click on this icon to claim and open the task for immediate 
attention. 

 
 

  Delete: This trash can icon is found in the Worklist view and the Attachments tab. Click on this 
icon to delete a task or attachment. Only the initiator of the form or the attachment can perform this 
function. 
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  Edit: This pencil icon is found in the Worklist view and in the Audit view of a task under the 
Archived tab to allow change of the task description. 

 

  Favorites - Add: This hollow star is found in the Directory Panel. Click on this icon to add a 
form in the Favorites category. 

 

  Favorites - Remove:  This solid star icon is found in the Directory Panel. Click on this icon to 
remove a form from the Favorites category. 

 

  Forwarding: This icon is found in the Worklist view and Task Details tab. Click on this icon to 
forward a task to another user. In the Forwarding tab, this icon (with green arrow) appears next to 
the name of the user who will receive the forwarded task. 

  

  Lock: This lock icon is found under the Task Details tab. Click on this icon to lock the task and 
prevent others from claiming it. 

 

  Remove Task: This icon is found under the Task Details tab. Click on this icon to abandon 
the task and remove it from the Worklist view. 

 

  Return Task: This icon is found under the Task Details tab and appears for a form that had 
been forwarded to you. Click on this icon to return the task to the previous user. 

 

 

  Save to Worklist (Draft): This icon is found under the Form tab to allow saving of a draft copy 
of the form for future editing. The same icon will also appear next to the form on the Worklist view, 
identifying that form/task as a saved draft. 

 

  Share(d) Task: In the Worklist view, this icon represents a shared task. In the Task Details tab, 
click this icon to share the task with another user. 

 

  Take Form Offline: This icon is found under the Form tab. Click on this icon to save a copy of 
the form on the computer or an external device. 
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7.6.2 Searching for a Form 
 

On top of the Form Directory Panel is a Search box to help you find the forms easily. Type the name 
of a particular form in the Search field and a list of all forms that match the search criteria will 
appear. As you type a character, any form that has that character in its name will appear until the 
search parameter is narrowed to the form you want. Click the "x" button to the right of the box to exit 
the search. 
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7.6.3 Opening a Form 
 

You can open a new form from the Form directory Panel on the left side of the window or an existing 
form from any of the Form Manager tabs on the right side of the window. See example of Form 
Manager below. 

 

 
 
 

Opening a New Form 
In the Directory Panel on the left side of the window, open a new form in any category by 
double-clicking on the form name rather than the star icon next to it. Clicking the star icon 
adds/removes the form to/from the Favorites category. 

 

Opening an Existing Form 
Position the mouse pointer on an existing form to highlight it and double-click to open it. 
 
NOTE:  Placing the mouse pointer over a task will also display a black box with detailed 
information about the task (see example above). 
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7.6.4 Completing a Form 
 

To complete a form, you can display the Document Message Bar and highlight the form fields. 

 

1. Click on the forms button  on the left navigation pane to display the Document Message 
Bar. 

2. Click the Highlight Fields button  on the right of the message bar to highlight the form 
fields. 

3. To fill out the form, place the mouse cursor in each field or use the tab key to advance to the 
next field as necessary. When ready, click the Complete button on the right bottom corner of 
the window. The completed form will be saved to the Archived system. 
  

 
 

4. To exit the form, click the X button on the top right corner of the page to exit the form view. 
5. A dialog box appears to confirm whether or not you want to close the form and alerts you to 

save any changes made. Click OK when ready. 
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6. The completed form will appear under the Archived tab. Hit F5 key to refresh the screen as 
necessary. 

 

 
 



AVS eForm Service User Guide   Revision:   6.0 
   Date: 08/15/2013  

 

UNCONTROLLED COPY 
50 

7.6.5 Saving a Form Offline 
To save the form to the hard drive or external device, click on the 'Take this form offline' button (as 
shown below).  This takes the form outside of the user interface.   

IMPORTANT:  Copies of forms saved Offline cannot be uploaded (saved) back to the Form 
Manager Worklist. 

 
 

The 'Save a Copy' box appears to allow you to save the form as a .pdf file only.  Choose the location 
to save the file, type in a file name, and click the Save button. 

 
 

 

Related Topic: 

Saving a Form to PDF 
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7.6.6 Saving a Form to PDF 

To save the form in .pdf format, click the Save icon  on the tool bar above the form. In the Save 
a Copy dialog box, rename the file as necessary and save to a preferred file location. 

 
 

 
  

 
 

 
 
 

Related Topic: 

Saving a Form Offline 

 

7.6.7 Saving to Worklist (Draft) 
 

If you need to save the form for future editing or completion, you can save a draft copy of a form so 
that you do not lose your existing work. This does not submit the form. 

1. With the form tab open, click the Save to Worklist (Draft) button on the bottom left corner of the 
form. 
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2. A confirmation bubble briefly appears to confirm that that the form has been saved to the 
Worklist view. 
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3. When you exit the form and go to the Worklist view, the Save to Draft icon appears next to the 
form (see example below). 
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7.6.8 Claiming a Shared Form 
Electronic form users can claim a shared task by performing the steps below. Shared tasks have the 

 icon to the left of the tasks. 

 
1. Double-click on the shared task in the Worklist view to open it. 
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2. The Task Details window opens. Click on the left icon  to claim the task and add it to your 

own Worklist for future work. Click the right icon  to claim and open the task for immediate 
attention. 
 

 

 
 

Related Topic: 

Manage Worklists 
  

 

7.6.9 Emailing a Copy of the Form 
 

The preferred way to share a form with another user is by using the Forwarding option in Form 
Manager.  However, you may use the email option to share the form with users who do not have an 
AVS account. 

 
1. Click the Email icon on the toolbar above the form. 
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2. A dialog box appears for you to select one of two options to email the document. Click the Send 
Copy button to send a copy of the PDF file, including your changes, as an attachment to your 
email. 

 

 
 
 
 
 
NOTE:  If the Email icon is not visible, position the mouse pointer between two icons on the left side 
of the toolbar and right-click to display a drop-down menu. Select File, and then click Share Files to 
display the icon on the toolbox.  
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7.6.10 Forwarding a Form 
The Forward function can be used to forward a form to another user for review purposes, 
collaboration, or assistance in completing the form. This does not submit the form or route it to the 
next stage in the workflow process.  

Forwarding a form can be done from either the Worklist tab or from the Task Details tab (if 
applicable), as shown in the examples below. 
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1. Click the Forwarding icon to open the Forwarding window as shown below. 
 

 
 
  

2. To locate a user, type the user's name in the text field and click the Find button or press Enter 
on the keyboard. 
 
NOTE:  You can enter either the first name or the last name (not both) or the format of 
(lastname, firstname). User name is not case-sensitive.   
  

3. Select the desired user from the list (see example below) and click on the Forwarding icon  
next to the user name. The result of the search may return more than one name (i.e., for the last 
name Smith).  Scroll down the list and select the appropriate individual. 
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4. Click the Add button to add the user to the Recipient list. 
5. Click OK to forward the task. 
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Returning a Forwarded Form 
1. To return the forwarded form back to the sender, open the form in the Worklist. 

2. On the Task Details tab, click the “Return this task to the previous user” icon on the 
bottom of the window. 

 
 
 

3. The form disappears from your Worklist view and a yellow message bubble appears on 
the top menu bar to notify you that the form has been added to the previous user’s 
Worklist queue. 
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7.6.11 Printing a Form 

To print a form, click on the Print icon  on the toolbar above the form. Clicking on File > Print 
from the main top menu bar of the Internet browser will not print the form. 

 

 
 
 
 

NOTE:  If the Print icon is not visible, position the mouse pointer between two icons on the left side 
of the toolbar and right-click to display a drop-down menu. Select File, and then click Print to 
display the icon on the toolbar. 
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7.6.12 Changing the Description for a Task  
The description for each task can be changed (or added) while in Worklist view or in Archived 
view. See examples below. 

NOTE:  This description is used for organizing your own Worklist and Archived views and does not 
go with the task when it is sent to the next stage of the workflow process. The only exception is 
when the task is forwarded to another user since the description stays only with forwarded tasks. 
  

Changing Task Description in Worklist View 
Click inside the Description section of the task and type the description in the text box. 
Press Enter on the keyboard or click outside the text box when finished.  
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Changing Task Description in Archived View 
For the Archived view, there are two ways to change the task description: 

One way is by clicking inside the Description section of the task and typing the description in 
the text box. Press Enter on the keyboard or click outside the text box when finished. 
  

 
 
  

Another way is by double-clicking on the task in the Archived view above to open it and then 

selecting the Audit tab. Click once on the task and the Edit icon  appears on the left 
bottom corner of the window, as shown in the example below. The Edit icon is also visible 
when clicking on the View icon  to open the form. 
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Click on the Edit icon and the "Change Task Description" window appears for you to enter 
the description of the task.  

 

 
  

Click Save when done or Cancel to go back to Audit view. 

 

7.7 Problems Accessing the System 

7.7.1 Locked Account 
 

To unlock your account, contact AVS National Service Desk at 1-877-287-6731 or email AVS 
National Service Desk 

 
 

Related Topic: 

User Support 
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